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Chapter 1. Preface

This chapter gives an introduction to RCE.

1.1. Abstract

RCE (Remote Component Environment) is an open source software that helps engineers, scientists
and othersto create, manage and execute complex cal culation and simulation workflows. A workflow
in RCE consists of components with predefined inputs and outputs connected to each other. A
component can be asimulation tool, atool for dataaccess, or auser-defined script. Connections define
which data flows from one component to another. There are predefined components with common
functionalities, like an optimizer or a cluster component. Additionally, users can integrate their own
tools. RCE instances can be connected with each other. Components can be executed locally or on
remote instances of RCE (if the component is configured to alow this). Using these building blocks,
use cases for complex distributed applications can be solved with RCE.

1.2. Intended Audience

Theintended audience of thisdocument consists of engineers, scientists, and everybody elseinterested
in devel oping automated workflows with RCE.

1.3. License Information

RCE is published under the Eclipse Public Licence (EPL) 1.0. It is based on Eclipse RCP 4.8.0
(Photon), which is also published under the Eclipse Public Licence (EPL) 1.0. RCE also makes use
of various libraries which may not be covered by the EPL; for detailed information, see the file
"THIRD_PARTY" in the root folder of an RCE installation. (To review this file without installing
RCE, open the RCE release .zip file.)

For downloads and further information, please visit https.//rcenvironment.de/.

1.4. Compatible Operating Systems

RCE releases are provided for Windows and Linux. It isregularly tested on
* Windows 7

* Windows 10

* Windows Server 2016

* CentOS7

* Debian9

e SUSE Linux Enterprise Desktop ("SLED") 12 SP2



https://rcenvironment.de/
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1.4.1.

1.4.2.

* Ubuntu 18.04LTS

Support of 32 Bit Operating Systems

Starting with release 8.0.0, RCE is only shipped for 64 bit systems. If you still require 32 bit packages,
you can continue to use previous RCE releases, but there will be no standard feature or bugfix updates
for them.

Known Issues

1.4.2.1. KDE on Red Hat Enterprise Linux 7

On Red Hat Enterprise Linux 7 with KDE 4, RCE (like any other Eclipse-based application) can cause
asegmentation fault at startup. If you encounter such an issue, you can try choosing adifferent GTK2
theme:

1. Open the System Settings application (systemsettings).
2. Goto Application Appearance
3. Open GTK page

4. Switch the GTK2 theme to "Raleigh” or "Adwaita" and click on Apply

1.4.2.2. KDE with Oxygen

On Unix Systems using KDE as desktop environment and Oxygen as theme it can happen that RCE
crashes when certain GUI elements are shown. It is a known issue in the theme Oxygen and happens
on other Eclipse-based applications as well. If you encounter such an issue, please choose a different
theme like "Raleigh” or "Adwaita’.

1.4.2.3. Jython scripts are executed sequentially

The Script component can use Jython for the evaluation of scripts and the pre- and postprocessing of
integrated tool s always uses Jython. Dueto aknown bug in the Jython implementation it isnot possible
to execute several Jython instances in parallel. Therefore, the execution will be done sequentialy. If
several Script components should be executed in parallel, Python should be used instead.

1.4.2.4. 32-bit Java is not supported

Running RCE with a 32-bit Java Runtime Environment doesn't work. On some operating systems an
error dialog will be displayed in this case, on some other systems nothing will happen at all. Therefore,
always make sure a 64-bit Java Runtime Environment is used to run RCE.




Chapter 2. Setup

This section describes the installation and configuration of RCE.

2.1. Installation on Linux

2.1.1.

2.1.2.

Prerequisites

Torun RCE onasystem, the only prerequisiteisan installed Java Runtime Environment (JRE), version
8ul61 or above. If you don't already have one on your machine, use your system's package manager
to install it; the most common choice is the OpenJDK JRE.

Note

Some pre-installed components of RCE have additional dependencies. Please refer to Section 2.3 (Workflow
Components) for more details.

Installation

There are two installation options on Linux: installing RCE from .deb/.rpm packages, or extracting it
from a zip file (which was traditionally used by earlier versions of RCE). Whenever possible, using
the packages is recommended, as RCE is automatically installed into the proper system locations, and
can be cleanly managed using your distribution's package manager. If you are using a Debian-based
distribution, apackage repository is provided aswell, which makesit even easier to install and upgrade
RCE. The following table compares these options:

Table2.1. Linux installation options

Installation |Multi- Daemon |Installing [File Updating to a|Verifying |Registers
type user operation |more system  |new version digital start
operation |(system |than one|location signatures menu
supported|service) |version at entry and
supported|the same icon
time

Using the|yes yes no [usr/ Using the|automatic|yes
package shar e/ |distribution’'s
repository rce update manager
(Debian/ (automatic  or
Ubuntu/ manual)
Mint only)
Manual yes yes no [usr/ Manually manual  |yes
installation share/ |download and|(gpg/
of rce install a newer |shasum)
the.deb/.rpm package
package
Unpacking |no no yes (anywhere) Use "Help/manual  |no
the .zipfile > Check for|(gpg/

Updates" in|shasum)

RCE -or- delete

the old
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Installation |Multi- Daemon |Installing [File Updating to a|Verifying |Registers
type user operation |more system  |new version digital start
operation |(system |than one|location signatures menu
supported|service) |version at entry and
supported|the same icon
time
installation
directory and
manually
download and
unpack a newer
zipfile

2.1.2.1. Debian/Ubuntu/Mint - Installing from the Package
Repository (recommended)

To register the RCE .deb package repository in your system, you have to add the repository location,
and add the RCE signing key. Then, you can install RCE like any other software package. There are
two different waysto do this, both leading to the the same result.

» (Option 1) If you prefer to use graphical tools, start the program "Synaptic"; if it is not available,
install if from your Software Center - or similar - first. Please note that this option might not be
availableon all systems. If thisisthe casefor you, you can still install the package using the manual
process listed as Option 3.

» Open "Settings > Repositories’.

« Click on "Authentication keys", and then on "Download akey...". Copy the text

258BC129EDA2389D3ECD2DE6BA880CB39DC1 CE34 ‘

into the dialog that appears and click "Ok". The list of keys should now contain an entry "RCE
6.x-9.x Automatic Signing Key <rcenvironment-builds@lists.sourceforge.net>".

Click on a section named "Additional Repositories’, "Other Sources" or similar. Select the
"Add..." or "Add new..." option. Copy the text

deb https://software. dlr.de/updates/rce/9.x/products/standard/rel eases/| at est/deb/ / ‘

into the dialog that appears and click "Ok".

Close the settings dialog and click "Reload” to update the list of available software. After this,
you should find an entry "rce" in this list (for example, using the Search button), which you
can ingtall like any other software. Y ou will also receive automatic notifications when a newer
version of RCE 9.x is available.

» (Option 2) If you prefer to execute al steps manually using the command line, enter the following

commands as "root" (or with the "sudo" prefix). Obvioudly, thisis the most complicated way.

apt - key adv --recv-key 258BC129EDA2389D3ECD2DE6BA880CB39DC1CE34 ‘

Note

If you see a message containing the text " RCE 6. x-9.x Aut omati c Si gni ng
Key <rcenvironnent-builds@i sts. sourceforge. net>", the key import was successful.
Sometimes, this step failswith themessage"key [...] not found on keyserver; gpg: no
val i d OpenPGP data found. " If thishappens, just repeat the command a few times until it works.
This issue may also be caused by an outdated gpg version (gpg version 2.0.9 on SUSE Linux Enterprise
Desktop 11 is known to be problematic, while gpg version 2.0.22 works).

The RCE signing key is published on the keyserver pool . sks- keyser ver s. net , which is the default
keyserver for most distributions of gpg. If your installation does not default to that keyserver, you may
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try to explicitly specify the keyserver at hkps: / / hkps. pool . sks- keyservers. net orathkp://
pool . sks- keyser ver s. net . Please consult the documentation of your installation of gpg to determine
how to specify the keyserver.

If you cannot access keyservers at all for some reason, you can also download the key manually from

‘htt ps://github. conmrcenvironnent/rce-signing/ bl ob/ naster/rce_9. x_si gni ng_key. asc ‘
After the download has completed, you can import the key by executing

‘apt -key adv --inport rce_9.x_signing_key. asc ‘

from the command line.

e echo "deb https://software.dlr.de/updates/rce/9.x/products/standard/rel eases/| atest/deb/ /"
>/etc/apt/sources.list.d/dlr_rce_9_rel eases.|ist

Note

Although it may be split across lines here, this command must be executed asasingleline.

e apt-get update ‘

e apt-get install rce ‘

Note

For previousversionsof RCE there existed ascript that imported the signing key from github and added the software
repository to the system repositories automatically. Due to recent changes to our workflow for producing RCE
releases, we are currently improving and adapting these scripts. Once they are available, you can find them at

https://github. com rcenvironnment/rce-signing ‘

Executing the script

regi ster_rce_9.x_deb_repository.sh ‘

will import the signing key onto your system and subsequently register the repository with your package manager.

Onceyou haveinstalled RCE using either of these approaches, any RCE 9.x upgradewill automatically
show up via the update mechanism of your operating system. Depending on the upgrade settings of
your system, they may be installed automatically, or be presented to you for selection.

Note

Although technically possible, RCE 9.x will not auto-upgrade to 10.x (or higher) to maintain compatibility within
networks of RCE 9.x instances. Y ou will need to manually install the 10.x repository location in order to upgrade.

2.1.2.2. Debian/Ubuntu/Mint - Installation of the .deb Package
(alternative)

To install the .deb file manually, download the latest version from

‘htt ps://software. dlr.de/ updates/rce/ 9. x/ product s/ standard/ rel eases/ | at est/ deb/ ‘

You can either install it using the graphical package management tools of your distribution (double-
clicking the .deb should start them), or by running sudo dpkg -i <fil ename>fromaterminal.
To upgrade an existing installation, simply install the newer package. The package manager will detect
the upgrade and handle it properly.

2.1.2.3. CentOS/Red Hat - Installation of the .rpm Package
(recommended)

Toinstall the .rpm file, download the latest version from

‘htt ps://software.dlr.de/ updates/rce/ 9. x/ product s/ st andard/ rel eases/ | atest/rpm
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You can either install it with the graphical package management tools of your distribution (double-
clicking the .rpm should start them), or by running the appropriate installation command as the "root"
user. On CentOS or Red Hat, thecommandisyumi nst al | <fi | ename>;onSUSE, usezypper

install <fil enanme>.Toupgradean existing installation, simply install the newer package. The
package manager will detect the upgrade and handle it properly.

2.1.2.4. All Distributions - Running from the .zip File (alternative)

2.1.3.

If none of the previous installation options fits your needs, you can also extract RCE from a zip file
downloaded from

‘https://softmare.dlr.de/updates/rce/Q.x/products/standard/releases/latest/zip/ ‘
* If you prefer graphical tools, double-click the .zip file to open it with your distribution’s archive
manager. Extract it to alocation of your choice, and open that location in your file-system explorer.
Typically, double-clicking the "rce" executable will work out of the box and start RCE. If this does

not happen, right-click the executable, open its "properties’ section (or similar), and look for an
option to mark it as executable. Confirm the dialog, then double-click it again.

* If you prefer using the command line, use theunzi p command to extract the zip file to alocation
of your choice. In the location where you unpacked the files to, you can usually simply enter
.lrce ‘

to start RCE. In some cases, you may first need to make it executable using the command

chmod +x rce

Note

The path to your installation location must not contain any colons to avoid Java Virtual Machine errors when
starting RCE.

Digital Signatures and Download Verification

Starting with RCE 6.x, we provide digital signatures for our releases. These can be used to verify the
integrity of the downloaded files, as any unsigned software can be tampered with while downloading
it over an unsecured (HTTP) connection. Thisisespecially important when installing RCE from auser
account with root privileges, for example as a system daemon

For each type of release files (.zip, .deb, and .rpm files), a SHA256SUM asc file is provided next
to the actual files. Thisfile contains checksums for each release file, and these checksums are signed
with our release key. It is named "RCE 6.x-9.x Automatic Signing Key", has the id 9DC1CE34, and
isvalid until Nov 22, 2020. Its full fingerprintis258B C129 EDA2 389D 3ECD 2DE6 BA88
0CB3 9DCl1 CE34.

On Linux, the required command-line tools to verify these signatures (gpg and shasum/shalsum/
sha256sum) are usually already installed as part of your distribution. If they are not, use your system's
package manager to install them. To perform the actua verification:

» Execute

gpg - - recv-key 258BCL29EDA2389D3ECD2DE6BASS0CB39DCL CE34 \

toimport the signing key. Thisonly needsto be done once per key, e.g. oncefor all RCE 9.x releases.

Note

If you see a message containing the text " RCE 6. x-9. x Aut omati c Si gni ng
Key <rcenvironnent-buil ds@i sts. sourceforge. net>", the key import was successful.
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Sometimes, this step fails with the message "key [...] not found on keyserver; gpg: no
val i d OpenPGP data found. " If thishappens, just repeat the command afew times until it works. This
issue may also be caused by an outdated gpg version (gpg version 2.0.9 on SUSE Linux Enterprise Desktop 11
is known to be problematic, while gpg version 2.0.22 works).

The RCE signing key is published on the keyserver pool . sks- keyser vers. net, which is the default
keyserver for most distributions of gpg. If your installation does not default to that keyserver, you may
try to explicitly specify the keyserver at hkps: // hkps. pool . sks- keyservers. net or a hkp://
pool . sks- keyservers. net . Please consult the documentation of your installation of gpg to determine
how to specify the keyserver.

If you cannot access keyservers at all for some reason, you can also download the key manually from
https://github. com rcenvironment/rce-signing/ bl ob/ master/rce_9. x_si gni ng_key. asc ‘

After the download has completed, you can import the key by executing

apt-key adv --inport rce_9.x_signing_key.asc ‘

from the command line.

» Download the SHA256 SUMS. asc filefrom the samelocation astheinstallation package and place
it in the same folder as the downloaded .zip-file. Run

gpg --verify --yes SHA256SUMS. asc ‘

in the location where you saved it to; this verifies the digital signature. Inspect the output to see if
it is correct; you should find the text "Good signature from "RCE 6.x-9.x Automatic Signing Key
<rcenvironment-builds@lists.sourceforge.net>" (or a similar trandation). Once the command has
terminated, you should find afile SHA256 SUVS in the current folder.

Note

When following these steps, it is normal to receive a warning about the fact that the owner of this key cannot
be verified. If you have received this user guide from a trustworthy source (e.g. an official RCE project site
secured with HTTPS), you can assumethat the key is correct, asthe command used to import the key has already
verified the key's integrity. Alternatively, you can fetch the key's fingerprint from a trustworthy source (e.g.
from a secure intranet page, or the official @rcenvironment Twitter feed accessed viaHTTPS) and compare it
with the one shown in the command's output. If they match, you can trust that you are using the authentic key.

* Run

shasum - ¢ SHA256SUNB \

in the same folder. This verifies that the actual download matches what has been digitally signed
for the release. Y ou should see the install ation package's name, followed by "OK".

Note

On some distributions, you need to use shalsumor sha256suminstead of shasum

2.1.4. Starting RCE as a GUI Client

Once your RCE instance has started, you can open the configuration file with the menu option "Help
> Open Configuration File". Edit thefile, saveit, and then restart RCE using the "File > Restart" menu
option to apply the changes. There are configuration templates and other information available viathe
"Help > Open Configuration Information" option. The available configuration settings are described
in the configuration chapter.

Note

On Ubuntu, the Ubuntu overlay scrollbars can sometimes lead to problems with the RCE GUI. To avoid
these problems, you can start RCE from a terminal with env LI BOVERLAY_SCROLLBAR=0 ./rce
to disable the overlay scrollbars for RCE. Alternatively, if you want to disable the overlay scrollbars

7
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2.1.5.

2.1.6.

permanently for al programs, execute echo "export LI BOVERLAY_SCROLLBAR=0" > /etc/X11/
Xsessi on. d/ 80over | ayscrol | bar s asasuperuser and then restart your computer.

Starting a Non-GUI ("Headless") Instance

RCE can aso be run from the command line without a graphical user interface (which is called
"headless’” mode), which uses less system resources and is therefore recommended when the GUI is
not needed.

To run aheadless RCE instance, open atermina and run the command

‘rce --headl ess -consol e ‘

While RCE is running, you can enter various console commands described in Section 3.3,
“Commands’; note that you need to prefix all RCE commands with "rce" here. To perform aclean
shutdown, for example, typer ce st op and press enter.

Installation as a Daemon on a Linux Server

For ad-hoc or temporary RCE network setups, running a headless RCE from the command line is
perfectly fine. For more permanent installations, however, we recommend installing RCE as a system
daemon instead. This has the advantage that RCE automatically shuts down when the server is shut
down, and automatically restarts when the server does.

2.1.6.1. Installation and Daemon Management

Executing the following steps will install RCE as daemon. An RCE daemon will start automatically
on system boot and stop before system shutdown.

The recommended (and supported) way to install a Linux daemon is to install RCE from a .deb
or .rpm package, or (equivalently) installing it from the APT repository. While installing a daemon
from the .zip file distribution can be made to work, it creates unnecessary complications regarding
installation paths and file permissions. Asregistering a daemon requiresroot privileges anyway, there
should be no reason to use the .zip file; if you have a compelling use case for this, please contact the
RCEteamatr ce@l r . de.

Once RCE is properly installed, registering it as a daemon is very simple. A command named r ce-
daenon isprovided to control thewhole daemon life cycle. The only manual step you need to perform
before using that command is creating a user account that the daemon will run under. For now, this
account has to be named r ce- daenon; use your distribution's console commands or GUI tools to
add it. (Please note that this account needs to have a home directory to hold the daemon's profile
directory.) Future RCE versions will make this account name customizable.

Once this user account is created, you can use the following commands to manage the daemon
installation:

» rce-daenon install -ingalsand starts the daemon instance
e rce-daenon uninstall - stops and uninstalls the daemon instance; the profile directory
remains unchanged

* rce-daenon start /rce-daenon stop/rce-daenon restart - standard daemon
controls

» rce-daenon | ocat e - printsthelocation of the daemon's RCE instance's profile directory and
relevant files

e rce-daenon st at us - displaysif the RCE daemon is currently running or not
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2.1.6.2. Daemon Configuration

After ingtallation, the daemon instance will be started automatically. This will create a default
configuration fileif it does not exist yet.

To configure the daemon instance, user ce- daenon | ocat e tofind itsconfiguration file, edit and
saveit, and then user ce- daenon rest art to apply the new configuration.

Note

The need to restart the daemon is temporary; future versions of RCE will apply configuration changes as soon as
the configuration file is changed.

2.2. Configuration

2.2.1.

2.2.2.

This section describesthe configuration of RCE. Configuration isdonewithin one single configuration
file. It is located in the profile directory. From the graphical user interface, you can easily access it
from the tool bar or the Help menu. Note: To apply changes you need to restart RCE. The format of
the configuration file is JISON. See http://www.json.org/ for the format definition. Also refer to the
example configuration filesin the installation data directory.

Configuration Locations and Files

Starting with RCE 6.0.0, all user datais strictly separated from the RCE installation itself. Each set of
user datais contained in a so-called "profile". Each profile defines what is called an RCE "instance".
Each profile (and therefore, each instance) belongsto exactly one user, and each user can have multiple
profiles. The default profile is located within the user's "home" directory ("/home/<user id>/" on
Linux), in the ".rce/default" sub-folder.

Note

Note that ".rce" is a hidden directory; you may need to set operating-specific options to see hidden files and
directories.

All manual configuration takes place in the profile's central configuration file, "configuration.json”.
As of RCE 9.0.0, most configuration settings only take effect on startup, so you need to restart RCE
after editing it. (Thiswill be changed in afuture release.) This appliesto all types of installations.

Configuration Parameters

Configuration parametersare grouped within the configurationfile. Below arelistsof the configuration
parameters. Thereis one list per JISON configuration group. Y ou can find example configurationsin
"configuration_reference_sample" in the installation data directory or by opening the configuration
information in RCE.

Table2.2. " general”

Configuration key Comment Default
value
instanceName The name of the instance that will be shown to al users|"<unnamed

in the RCE network. The following placeholders can be|instance>"

used within the instance name:
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Configuration key

Comment

Default
value

* ${hostName} is resolved to the local system's host
name.

o ${systemUser} is resolved to the Java "user.name’
property.

o $HprofileName} is resolved to the last part of the
current profile'sfile system path.

» ${version} isresolved to the build id.

Example: "Default instance started by \"${ systemUser}\"
on ${ hostName}".

isWorkflowHost

If set to true, the local instance can be used as aworkflow
host by other RCE instances. |.e., theworkflow controller
can be set to thisinstance and the workflow datais stored
there as well.

fase

isRelay

If set to true, the local node will merge all connected
nodes into a single network, and forward messages
between them. This behaviour is transitive; if a relay
node connects to another relay node, both networks will
effectively mergeinto one.

If set to false (the default value), the local node can
connect to multiple networks at once without causing
them to merge.

false

tempDirectory

Can be used to override the default path where RCE
stores temporary files. Useful if there is little space in
the default temp file location. Must be an absolute path
to an existing directory, and the path must not contain
spaces (to prevent problems with tools accessing such
directories). The placeholder ${systemUser} can be used
for path construction, e.g. "/tmp/custom-temp-directory/
${ systemUser}"

An'rce-
temp"
subdirectory
within the
user or
system temp
directory.

enableDeprecatedinputTab

If set to true the tab 'Inputs is enabled again in the
properties view of running workflows. It is disabled
by default due to robustness and memory issues. It is
recommended to use the 'Workflow Data Browser' to see
inputs received and outputs sent.

false

Table 2.3. " backgroundM onitoring"

Configuration key Comment Default
value

enabledlds Commarseparated list of identifiers referring to certain
kind of monitoring data that should be logged
continuously in the background. Currently, only
'basic_system_data is supported.

interval Seconds Logging interval 10

Note

IMPORTANT: When setting up a network of RCE instances, keep in mind that the RCE network traffic is
currently not encrypted. This means that it is not secure to expose RCE server ports to untrusted networks like

10
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the internet. When setting up RCE connections between different locations, make sure that they either connect
across a secure network (e.g. your institution'sinternal network), or that the connection is secured by other means,
like SSH tunneling or a VPN. Alternatively, you can set up SSH connections in RCE instead of the standard RCE

connections.

Table2.4. " network"

Configuration key Comment Default
value
requestTimeoutM sec The timeout (in milliseconds) for network requests that | 40000
are made by the local node. If this time expires before a
response is received, the request fails.
forwardingTimeout Msec | The timeout (in milliseconds) for network requests that | 35000
are forwarded by the local node on behalf of another
node. If this time expires before a response is received,
an error response is sent back to the node that made the
request.
connections A map of al connections that the local instance triesto|{} (an
establish on startup. This alows the local instance to act | empty map
as a client. For each connection a unique identifier (id) |in JSON
must be given. format)
connectiong/[id]/host I P address of the host to connect to. Host names and 1Pv4 |-
addresses are permitted.
connectiong/[id]/port Port number of the remote RCE instance. -
connectiong/[id]/ If set to true, the connection is immediately established|true
connectOnStartup on startup.
connectiong/[id]/ The initia delay, in seconds, to wait after a failed or|-
autoRetrylnitial Delay broken connection before a reconnect attempt is made.
This configuration must be present to enable the auto-
reconnect feature.
connectiong/[id]/ A decima-point vaue >= 1 that the delay time is|-
autoRetryDelayMultiplier | multiplied with after each consecutive connection failure.
This provides an "exponential backoff" feature that
reduces the frequency of connection attempts over time.
This configuration must be present to enable the auto-
reconnect feature.
connectiong/[id]/ Defines an upper limit for the delay time, even when|-
autoRetryMaximumDelay |applying the multiplier would create a higher value.
This can be used to maintain a minimum frequency
for retrying the connection. This configuration must be
present to enabl e the auto-reconnect feature.
serverPorts A map of al server ports that the local instance registers|{} (an
for other instances to connect to. This allows the local | empty map
instance to act as a server. For each server port a unique|in JSON
identifier (id) must be given. format)
serverPortg/[id]/ip I P address to which the local instance should be bound. |-
serverPortg/[id]/port Port number to which other instances connect to. -
ipFilter Allows to limit the incoming connections to a set of IP|-
addresses.
ipFilter/enabled If set to true, theip filter active. fase
ipFilter/allowedl Ps List of IP addresses, which are allowed to connect to the|[] (an empty
instance. listin JSON
format)

11
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Table 2.5. " component Settings'

Configuration key

Comment

Default
value

de.rcenvironment. cluster

Configuration of the cluster workflow component.

de.rcenvironment. cluster/

maxChannels

Maximum number of channéls, which are alowed to be
opened in parallel to the cluster server.

8

Table 2.6. " thirdPartylntegration”

Configuration key

Comment

Default
value

tiglViewer

Configuration of the external TiGL Viewer application
integration. This needs to be configured to enable RCE’s
TiGL Viewer view and thus, the TIGL Viewer workflow
component. Note: TiGL Viewer must be downloaded and
installed separately.

tiglViewer/binaryPath

The path tothe TiIGL Viewer executable file. Must be an
absolute path.

tiglViewer/
startupTimeoutSeconds

The timeout in seconds, to wait for the external TiGL
viewer application to start and determine its processid.

10

tiglViewer/embedWindow

If set to false, the external TiGL Viewer application
Window will not be embeded into RCE's TiGL Viewer
view.

true

Table2.7. " sshServer"

Configuration key Comment Default
value

enabled If set to true the local instance acts as an SSH server. fase

ip (deprecated alias:|The host's ip address to bind to. If you want to make|127.0.0.1

"host")

the SSH server accessible from remote, you should set
thisto the IP of the machine's external network interface.
Alternatively, you can set this to "0.0.0.0" to listen on
all available IPv4 addresses, if thisis appropriate in your
network setup.

port

The port number to which SSH clients can connect to.

idleTimeoutSeconds

The time to keep an idle SSH connection aive, in
seconds. For typical SSH usage, the default vaue is
usually sufficient. Higher values are, for exampl e, needed
when invoking long-running tools using the SSH Remote
Access feature.

10

accounts A map of accounts. For each account a unique identifier|{} (an
(account name) must be given. empty map
in JSON
format)
[account name]/| The hashed password for the account, if password-
passwordHash authentication is used. If the SSH account is configured
using the configuration Ul, the hash is automatically
computed and stored here.
[account name]/password| The password for the account. SSH passwords can|-
(deprecated) also be configured as plain text, which is however

not recommended. To prevent misuse of the configured

12
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Configuration key

Comment

Default
value

login data, any configuration file with SSH accounts
must be secured against unauthorized reading (e.g. by
setting restrictive filesystem permissions). A more secure
aternative isto just store the password hash.

[account name]/publicKey

The public key for the account, if keyfile authentication
is used. Only RSA keys in the OpenSSH format are
supported. The public key has to be entered here in the
OpenSSH format (a string starting with "ssh-rsa’, like
it is used for example in authorized_keys files). Only
applicable on RCE version 7.1 or newer.

[account name]/role

The role of the account. See next table for a list of the
possibleroles.

[account name]/enabled

If set to true, the account is enabled.

true

Table 2.8. Possibleroles for SSH accounts

Role name

Allowed commands

remote_access user (Standard role for | rajsysmon
using SSH remote access tools and

remote_access user)

workflows)
remote access (backwards| ralsysmon
compatibility dias for

remote_access admin

raJra-admin|sysmon|components

workflow_observer

components|net info|sysmon|wf listjwf details

workflow_admin

components|net infolsysmon|wf

local_admin cnjcomponentsimail |net|restart|shutdown|stopistats|tasks|
auth
instance_management_admin im|net infojauth
instance_management_delegate user |cnjcomponents|net|restart|shutdown|stop|statsjtasksjwf|ra-
admin|auth
developer <al>
Note

The command wf open is only accessible to the role devel oper, as it influences the GUI of the server-instance.

Table 2.9. " sshRemoteAccess"

Configuration key

Comment

Default
value

sshConnections

A map of SSH connections.Thisallowsthelocal instance
to act asa SSH remote access client. For each connection
aunique identifier (id) must be given.

{} @@n
empty map
in JSON
format)

sshConnectiong/[id]/
displayName

The name for the connection that will be shown in the
network view.

sshConnections/[id]/host

The remote RCE instance to connect to. Host names and

IPv4 addresses are permitted.

13
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Configuration key Comment Default
value
sshConnectiong/[id]/port | Port number of the remote RCE instance. -
sshConnectiong/[id]/ The login name for authentication. -
loginName
sshConnectiong/[id]/ Path to the private key file, if keyfile authentication|-
keyfileLocation is used. Only RSA keys in the OpenSSH format are
supported.
sshConnectiong/[id]/ This option should only be set if a private key that|false
noPassphrase requires no passphrase is used for authentication. If
set to true, RCE does not ask for a passphrase before
connecting.
sshConnectiong/[id]/ If set to true, the connection is immediately established|false
connectOnStartup on startup. (Only possible when the password is stored in
the secure store, which currently only works on Windows
machines.)
sshConnectiong/[id]/ If set to true, RCE will try to automatically reconnect the|false
autoRetry connection (every 10 seconds) if it can not be established
or is lost of a network error. (Only possible when the
password is stored in the secure store, which currently
only works on Windows machines.)

Table2.10. " smtpServer"

Configuration key Comment Default
value
host The IP address or hostname of the SMTP server, which|-
should be used for mail delivery.
port Port number of the SMTP server. -
encryption Can either be "explicit" or "implicit". Select "implicit" |-

if you want to connect to the SMTP server using SSL/
TLS. Select "explicit” if youwant to connect tothe SMTP
server using STARTTLS. Unencrypted connections are

not permitted.
username The login name for authentication. -
password The obfuscated password for authentication. Plaintext|-

password cannot be used here. To create the obfuscated
password from the plaintext password, you need to
use the Configuration Ul described in Section 2.2.3,
“Configuration Ul”

sender Email address, which should be displayed as the sender |-
in the sent email.

Note

The used SMTP server needs to be configured using the Configuration Ul described in Section 2.2.3.2, “Mail:
SMTP server configuration”, since the password needs to be obfuscated.

2.2.3. Configuration Ul

If you want to configure SSH accounts with passphrases or you want to configure e-mail support for
the instance, you need to use the Configuration Ul. Y ou can access the interactive tool by executing

14
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RCE from the command line with the option "rce --configure" or by using the "Launch Configuration
UI" script in the "extras' folder of your RCE installation directory.

Figure 2.1. Configuration tool for SSH account and SMTP server
configuration

|2/ Terminal =R

RCE Configuration Shell, editing profile : default

Select Action
[Remote Access: Add a new SSH account
Femote Access: Edit existing S5H accounts
Mail: Configure SMTP mail server

< Close >

2.2.3.1. Remote Access: SSH account configuration

If the RCE instance shall act asa SSH server, you can configure SSH accounts using the Configuration
Ul, which encrypts the SSH passwords before storing them in the configuration file.

Note

All SSH accounts configured with this tool initially have the role "remote_access _user", which allows to execute
commands needed for remote access on tools and workflows. If you want to change the role of an SSH account,
you can do this by editing the configuration file manually (see Table 2.8, “Possible roles for SSH accounts” ).

2.2.3.2. Mail: SMTP server configuration

If you use the tool output verification (cf. Section 3.2.8, “Manual Tool Result Verification™) and want
RCE to send the verification key viaemail, you need to configure an SMTP server. RCE does not send
e-mailsdirectly to the recipient, but instead sendsthe e-mailsto an SMTP server, which deliversthem
to the recipient. You need to use the Configuration Ul to configure such an SMTP server, since the
password used for authentication needs to be obfuscated before it is stored in the configuration file.
The SMTP server parameters that need to be configured are described in more detail in Table 2.10,
“"smtpServer"”

Note

Due to a known bug on Windows system with a German keyboard layout, the Configuration Ul inserts the
characters"g@" into atext field if you want to insert the @ sign. Y ou can manually remove the additional character

q.

15



Chapter 3. Usage

This chapter describes the main usage concepts.

3.1. Graphical User Interface

This section introduces the Graphical User Interface (GUI).

The GUI of RCE is composed of different views and editors (besides standard GUI elements such as
the menu bar, status bar, etc.). Views can be (re-)arranged by the user. They can even be closed and
opened again. Some views are closed by default, but can be opened as desired. To open a view go
to: Window _ Show view.

Figure 3.1. Workbench with different views and the wor kflow editor opened

[} RCE e i
File Edit  Search Run Window Help
3~ EIEIC BEARE" |
[25 project Explorer 52 = & ¥ < O||fdMpo 4wt 53 A FINISHED MDO_V12_2013-10-21 =a
1 MDO Project % Palette ;
[ixl) MDO_VLOWE Select
[] MDO_VL1wf s Select
[i) MDO V1.2 te—— ﬁ | Draw Connection
MDO_VI3wf Merger Mass Input Wing 12 Open Connection Editor
MDO_V14.mf
- (= Data Flow.
(& Execution
X Excel
t @ Saii
pt
Yy iy ar o
Control Optimizer Wing AeroCluster imple Wrapper
2 (= Studies
T (= Under Test
2 Cluster
pai/ied ¢ Design of Experiments
as i J S )
Converger Mesh Extract (& User Integrated Tools
A Mass
Wing
[i] Workflow List 22 @ = O [ Log | @ Network View | =] Properties |[E] Workflow Console | i Workflow Data Browser |/ Optimizer 2 =0
Name Status Property Value MDO_V1.2_2013-10-21
MDO_V13.2013-10-21 1. FINISHED i deaccilrs S
MDO_V13_2013-10-21 1. CANCELED showTitle true ghﬁ_*‘\-} - -
MDO_V11_2013-10-21 1... FINISHED title MDO_V1.2_2013-10-21 .... L - =
MDO_V13 2013-10-21 1. RUNNING traces Trace 2] _— ~
MDO_V1.2.2013-10-21 1. FINISHED Xhxes Xhuis [1] .
MDO_v1.0_2013-10-21 1... PAUSED Yixes Vs (1) ‘ .
0,86 T T T T T T T T T T T T T T T T T T T T T ™™
005 01 015 02 025 03 035 04 045 05 055 06 065 07 075 08 035 09 095 1 105 11 118
< » x
Add trace

+ || Disgram |Data

Left hand side:

» Project Explorer: View to manage projects. All relevant data including workflow files needs to be
organized in projects.

» Workflow List: Listsall activeworkflowsand allowsto manage them (stop, pause, resume, dispose).
Right hand side and center:
» Workflow Editor: Core view of RCE used to build and configure workflows.

o Palette: Lists al available workflow components. If RCE runs in a distributed environment
this includes local as well as remote workflow components. At the top, it also provides actions
for connecting workflow components. We show the connection editor in the following Figure.
Additionally, connections of the workflow are shown in the Properties view at the bottom, if the
background of the workflow editor is selected.
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Figure 3.2. Connection Editor

3 commconcoror . sl

Source Connections Target

Aerodynamic { Aerodynamic
-| hotinput

=] aero_xli 'E,
TEI mesh
Structure
'E, aeroxli

=| hotsose_dat E hotsose_dat
x stsrm_out

Structure =]
1.23 COQ_X

abf: pathtxt_cut

1.2z wehicle_mass

123 cacwf
1.23 €M

1.23 CW

Cancel

Bottom:
* Log: Showsall log output of RCE, e.g. error messages during workflow execution.

* Network View: Shows al RCE instances of the distributed RCE network and their published
workflow components. It also shows the outgoing connections of the own RCE instance and allows
to manage them (start, stop, etc.). Furthermore, you are able to see monitoring data like CPU or

RAM usage for each instance.

Figure 3.3. Network View

£ Network 22 ] ﬂ Workflow ... | =] Properties| El workflow ... &= Comman... ||E|Workﬂow... | =0

FFIOBFAE

4 = RCE Network
4 |7 Instances
4 [ RCEinstancel <Woarkflow Host> < 5elf=
4 [ Published Components
| Tempfilter (1.0)
> [~ Local Coemponents
4 [= Monitoring Data
= RCE CPU Usage: 0.00%
= RCE Tools CPU Usage: 0.00%
= Total CPU usage: 449% (Non-Instance processes: 4,49%, Idle: 95.51%)
B0 Total RAM usage: 6509 /16048 MIB
4 & Connections
& rcednstance.host:21000 (disconnected: active discennect)
4 = SS5H Remote Access
a4 & S5H Remote Access Connections
" rcessh.remote.host:31005 (disconnected)

» Workflow Data Browser: Shows workflow related result data.
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Figure 3.4. Workflow Data Browser

= Network D Workflow ... &7 :Properties &I workflow ... = Comman... EWMHIDW... =0

1% 1% O P | v
: fg‘ MDO_IDF_Sellar_2016-11-30_08:5%:32_17 <remote> -
4 ,5 MDO_CO_Sellar_2016-11-30_08:5%:13_16 <remote=
MDO_CO_Sellar_2016-11-20_08_59 13 _16-err.log [2 KB]
- (i) RunInformation
4 5D Timeline
a A\ Optimizer - Run 25 (2016-11-30 09:19:17) <remote>
i Hostinstance: SLED12 instance
Optimizer input file
Optimizer calculation file
Optimizer result file
4 = Inputs
.23 constl: 9.83749686996806E-5
.23 const2: 0.0065307551754074395
.23 f; 0.874960052524442
a = Outputs
# Done: true
.23 ¥1_optimal: 0.0

123 ylc_optimal 0.0

.23 y2c_optimal: 0.0

.22 z1_optimal: 0.0

.23 z2_optimal: 0.0

a4 |=| Execution Log
Optimizer-25_compl.log [3 KB]
Optimizer-25_err.log [0.17 KB]
Objective - Run 24 (2016-11-30 09:19:16) <remotex -

 Properties: Allows configuration of workflow components (e.g. Inputs/Outputs) if they are selected
in the workflow editor. View adapts to selected workflow component.

» Workflow Console: Shows all native console line output of integrated tools during workflow
execution. Provides full text search.

Figure 3.5. Workflow Console

5 Network | [J Workflow Data Browser | =1 Properties | El Workflow Console 22 | & Command Console |[i] Workflow List BEX =8

| Workflow/Component (V] Tool out [¥] Tool error ‘[ALL] v‘ ‘[ALL] -

search in messages

Type Time Message Component  Workflow *
ElTesl 2016-11-30 10:00:50,023 model. Optimizer mdo_v1.8.
ElTesl 2016-11-30 10:00:50,023  id_model - 'modell’ Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50,023 responses_pointer = 'responsesl' optimizer mdo_v1.3.
ElTeol 2016-11-30 10:00:50,023 single Optimizer mdo_v1.3.
ElTeol 2016-11-30 10:00:50,023 Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50,023 responses, Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50,023 id_responses = 'Tesponsesl' Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50,024 num objective_functions = 1 Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50,024 multi_ohjective_weights = 1.0 Optimizer mdo_v1.8. %
ElTeol 2016-11-30 10:00:50,024 num_nonlinear_ineguality_constraints = 4 Optimizer mdo_v1.8.
ElTesl 2016-11-30 10:00:50,024 nenlinear_inequality_upper_bounds = 0.001 0.5 1.0 1.0E30  Optimizer mdo_v1.8.
ElTesl 2016-11-30 10:00:50,024 nenlinear_inequality_lower_bounds = 0.0 -0.5 -1.0 3.0 Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50,024 no_gradients Optimizer mdo_v1.3.
ElTeol 2016-11-30 10:00:50,024 no_hessians Optimizer mdo_v1.3.
ElTeol 2016-11-30 10:00:50, Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50, Optimizer mdo_v1.8.
ElTeol 2016-11-30 10:00:50, Optimizer mdo v1.B. _

« m D

3.2. Workflows

This section describes the basics of workflowsin RCE.
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3.2.1.

3.2.2.

3.2.3.

Rationale

RCE is designed to execute automated, distributed workflows. Workflows consist of so called
workflow components which can be coupled with each other. Loops are supported, even multi-nested
ones.

Getting Started

To get started with workflows in RCE it is recommended to both read the following sections about
workflows and walk through the example workflows provided in RCE. The sections here refer to the
workflow examples whereit is useful and vice versa

Workflows in RCE are encapsulated in so called projects. To create the workflow examples project
go to: File _, New _ Workflow Examples Project. A dialog appears. Leave the default project
name or give it a name of your choice and confirm by clicking Fi ni sh. In the Project Explorer
on the left-hand side, the newly created project is shown. The example workflows are grouped in
sub folders. It is recommended to walk through the workflows following the prefix starting with

01_01_Hel I o_World. wf.

Workflow Components

Workflow components are either tools that are integrated by users or are provided by RCE supplying
multi-purpose functionality. The following list shows workflow components provided by RCE
grouped by purpose (workflow components that are deprecated (i.e., they are removed soon) or that
are not recommended to use anymore are left out):

» Data: Database

» Data Flow: Input Provider, Output Writer, Joiner, Switch

Evaluation: Optimizer, Design of Experiments, Parametric Study, Converger, Evaluation Memory

 Execution: Script, Cluster, Excel

XML: XML Loader, XML Merger, XML Vaues

CPACS: TiGL Viewer, VAMPzero Initidizer

Note

The Optimizer component uses the Dakota toolkit [https://dakota.sandia.gov/] in order to perform the actual
optimization. This toolkit is included in the RCE distribution, i.e., it is installed together with RCE. On some
systems, however, notably Ubuntu 18.04, thistoolkit cannot be executed, asthe required library libgfortran3is not
installed by default. If the toolkit cannot be executed, the Optimizer component will issue the error Coul d not

start optimzer. Maybe binaries are missing or not conpatible with system;

cause: Optimzer exited with a non zero exit code. Optimizer exit code = 127
(E#1543567120128) or similar in the workflow console and the data management.

On Ubuntu 18.04, this library can be installed by installing the package libgfortran3. For other systems, please
refer to the documentation or the administrator of your system in order to satisfy the missing dependency of the
Dakotatoolkit.

The example workflows in subfolder 02_Conponent G oups introduce some of the workflow
components provided. Additionally, there is a documentation for each workflow component available
in RCE. To accessit, you can either rightclick on a component in aworkflow and select Open Hel p
or press F1. A help view opens on the right-hand side. Moreover thereisan entry Hel p Cont ent s
in the Hel p menu where you can navigate to the component help you require.

The XML and CPACS components are able to read or extract datafrom an XML file viadynamicin-
or outputs. The XPathChooser isafeature that provides help selecting theitem, which shall beread or
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3.2.4.

extracted. Add anin- or output and pressthe XPat h choosi ng. . . button to open awindow where
you can select the XML file which contains the item that shall be selected. After choosing thefile, the
XPathChooser opens containing a tree, symbolizing the XML file. By selecting an element, the text
below is updated and displays the current path. The last two columns are used to choose attributes.
The attribute name can be selected viathe column At t r i but es. Inthe column Val ues the proper
value can be selected. Use adouble-click on an element to expand or fold the tree. The chosen XPath
will be written in the text field of the window in which the X PathChooser has been opened originally.
Using this text field, new paths can be created. Add a slash and the name of the node that shall be
created to the existing path. The new path will be added during the workflow run.

New XPaths can only be generated within the inputs tab. Using the outputs tab will cause an error.

Coupling Workflow Components

A workflow component can send data to other workflow components. Therefore, a so called
connection needs to be created between the sending workflow component and the receiving one. For
that purpose, workflow components can have so called inputs and outputs. A connection is aways
created between an output and an input. You can think of a connection as a directed data channel.
Datais sent as atomic packages which are not rel ated to each other (thereis no data streaming between
workflow components). Supported data types are:

Primitive data types:

» Short Text: A short text (up to 140 characters)

Integer: Integer number

Float: Floating point number
» Boolean:Boolean value (true or false)

Referenced data types (The actual data is stored in RCE's data management and only a reference is
transfered):

» FileFile
* Directory:Directory
Other data types

» Small Table:Table restricted to values of type Short Text, Integer, Float, Boolean (primitive data
types) (up to 100.000 cells)

 Vector:one-dimensional "Small Table" (one column) restricted to values of type Float
» Matrix:Small Table restricted to values of type Float

Not al of the workflow components support al of the data types listed. A connection can be created
between an output and an input if:

» Thedatatype of the output is the same as or convertible to the data type of the input.
» Theinput isnot already connected to another output.

Note that data from an output can be sent to multiple inputs, but an input can just receive data from
asingle output.

The following table shows which data types are convertible to which other types:
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Table 3.1. Data Type Conversion Table

To . Small | Short . .
From Boolean | Integer | Float | Vector | Matrix Table | Text File Directory

Boolean X X X

Integer X X

Float X

X | X | X | X

Vector

X | X | X | X | X

Matrix

Small
Table

Short X
Text

File
Directory,

3.2.5. Execution Scheduling of Workflow Components

The execution of workflows is data-driven. As soon as al of the desired input data is available, a
workflow component will be executed. Which input data is desired is defined by the component
developer (for RCE's default workflow components), the tool integrator, and/or the workflow creator.
The workflow component developer and tool integrator decide which options are allowed for a
particular workflow component. The workflow creator can choose between those options at workflow
design time. The following options exist:

Input handling:

 Constant: The value won't be consumed during execution and will be reused in the next iteration (if
thereis any loop in the workflow). The workflow will fail if there is more than one value received,
except for nested loops: All inputs of type Constant are resetted within nested loops, after the nested
loop has been finished.

e Sngle (Consumed): The input value will be consumed during execution and won't be reused in
the next iteration (if there is any loop in the workflow). Queuing of input valuesis not allowed. If
another value is received before the current one was consumed, the workflow will fail. This can
guard against workflow design errors. E.g., an optimizer must not receive more than one value at
one single input within one iteration.

* Queue (Consumed): Theinput value will be consumed during execution and won't be reused in the
next iteration (if there is any loop in the workflow). Queuing of input valuesis allowed.

Execution constraint:
* Required: Theinput valueisrequired for execution. Thus, the input must be connected to an output.

» Required if connected: The input value is not required for execution (e.g., if adefault value will be
used asfall back within the component). Thus, the input doesn't need to be connected to an output.
But if it is connected to an output, it will be handled as an input of type Required.

* Not required: The input value is not required for execution. Thus, the input doesn't need to be
connected to an output. If it isconnected to an output, theinput value will be passed to the component
if there is avalue available at the time of execution. Values at inputs of type Not required cannot
trigger component execution except if it isthe only input defined for a component. Note: With this
option, non-deterministic workflows can be easily created. Use this option carefully. If in doubt,
leaveit out.
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3.2.6.

Note: With RCE 6.0.0 the scheduling options changed. Below is the migration path:
* Initial was migrated to Constant and Required.

* Required was migrated to Sngle (Consumed) and Required.

» Optional was migrated to Single (Consumed) and Required if connected.

If you encounter any problems with workflows created before RCE 6.0.0, it is likely, that it affects
the migration to Single (Consumed) instead of to Queue (Consumed). We decided to migrate
conservatively to not hide any existing workflow design errors. So, if queuing of input values is
allowed for an input, just change the input handling option to Queue (Consumed) after the workflow
was updated. Another issue can affect the migration of Optional. If it affects an input of the script
component, check the option, which let the script component execute on each new value at any of its
inputs. Also check Not required as an alternative execution constraint option.

(Nested) Loops

Workflow components can be coupled to loops. A loop must aways contain a so-called driver
workflow component. Driver workflow components (group "Evaluation") are: Optimizer, Design of
Experiments, Parametric Study, Converger (seethe exampleworkflow "02_02_Evaluation_Drivers').
The responsibilities of a driver workflow component in aloop are:

» Send values to the loop and receive the result values.
* Finish the loop based on some certain criteria.

If aloop contains another loop, we speak of the latter as a nested loop. A nested loop can contain
again another loop and so on. To create workflows with nested loops (see example workflows in
"03_Workflow_Logic"), some certain concepts behind nested |oops must be understood:

» Loop level: If aloop contains another 1oop, that loop is considered as a nested loop with a lower
loop level. From the perspective of the nested loop, the other loop is considered as aloop with an
upper loop level.

* If adriver workflow component is part of a nested loop, you need to check the checkbox in the
"Nested Loop" configuration tab

» Data exchange between loops of different loop levels is only allowed via a driver workflow
component. Thereby, only particular inputs and outputs of driver workflow componentsare allowed
to be connected to inputs and outputs of the next upper loop level and particular ones to inputs and
outputs of the sameloop level. For example, if a'sameloop level' output is connected to aloop with
an upper loop level, the workflow won't succeed or might even get stuck. Below you find tables of
inputs and outputs for each driver workflow component and whether they must be connected to the
same loop level or to the next upper loop level.

Note
In the inputs and outputs tables of driver workflow components (in 'Inputs/Outputs’ properties tab), the loop
level requirement is present in a particular column for each input and output.

Table 3.2. Inputs of Optimizer

Input Loop Level

* - |lower bounds - start value To next upper
loop level

* - upper bounds - start value To next upper
loop level
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Input Loop Level
* - start value To next upper
loop level

* (Objective functions)

To same loop level

* (Constraints)

To sameloop level

d*.d* (Gradients)

To sameloop level

Table 3.3. Outputs of Optimizer

Output Loop Level

* _optimal To next upper
loop level

Done To next upper
loop level

* (Design variables)

To same loop level

Gradient request

To sameloop level

Iteration

To same loop level

Table 3.4. Inputs of Design of Experiments

Input Loop Level
* start To next upper
loop level

To sameloop level

Table 3.5. Outputs of Design of Experiments

Output

Loop Level

Done

To sameloop level

*

To same loop level

Table 3.6. Inputs of Parametric Study

Input Loop Level
*_start To next upper
loop level

To sameloop level

Table 3.7. Outputs of Parametric Study

Output

Loop Level

Done

To same loop level

*

To sameloop level

Table 3.8. Inputs of Converger

Input Loop Level
* dtart To next upper
loop level
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3.2.7.

3.2.8.

Input Loop Level
* To sameloop level
Table 3.9. Outputs of Converger
Output Loop Level
Converged To next upper
loop level
Converged absolute To next upper
loop level
Converged relative To next upper
loop level
*_converged To next upper
loop level
Done To same loop level
* To same loop level

Fault-tolerant Loops

Workflow components of aloop can fail. There are two kind of failures:

» A workflow component fails gracefully, i.e. it couldn't compute any results for the inputs received
but works normally. In this case, it sends a value of type "not-a-value" with the specified cause to
its outputs which finally are received by the driver workflow components as resullts.

» A workflow component fails, i.e. it crashes for an unexpected reason. In this case, the workflow
engine sends values of type "not-a-value" with the specified cause as results to the driver workflow
component.

In the "Fault Tolerance" configuration tab of workflow driver components, it can be configured how
to handle failuresin loops, for both kind of failures separately.

Manual Tool Result Verification

After the execution of an integrated tool, the results are sent via outputs to the next workflow
component (e.g. to the next integrated tool). By default, thisis done in an automated manner without
any user interaction. If the data should be verified by a person responsible for the tool before they are
sent further, manual verification of tool results must be enabled in the tool integration wizard in the
‘Verification' tab of the 'Inputs and Outputs' page.

In case manual verification of tool results is enabled, the results are hold after each tool execution
and the corresponding workflow component remains in state "Waiting for approval”. Then, there are
two options:

» Approvetool results: The tool results are sent viathe outputs to the next workflow component and
the workflow continues normally.

* Regject tool results: The tool results are not sent via the outputs to the next workflow component
and the workflow is cancelled.

To apply one of the options, aso called verfication key isrequired. The verification key isgenerated by
RCE after each tool execution and iswritten to afile on thefile system of the machine which executed
the tool. (The location is specified in the 'Verification' tab of the 'Inputs and Outputs' page in the tool
integration wizard.) Optionally, the verification key can also be sent via email if e-mail support is
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configured for the RCE instance where the tool isintegrated. (E-mail support can only be configured
using the Configuration Ul as described in Section 2.2.3.2, “Mail: SMTP server configuration”) E-
mail delivery can be enabled and the recipients can be defined in the 'Verification' tab of the 'Inputs
and Outputs' page in the tool integration wizard.

Oncetheverification key isknown (either fromthefileor an e-mail), performfollwing stepsto approve
or reject the tools results:

» Start an RCE instance with a graphical user interface. (Your tool must be available, i.e. it must
appear in the palette of the workflow editor.)

* Inthe menu bar at the top, go to Run -> Verify tool results...

» A dialog appears that guides you through the verification process.

3.3. Commands

This section introduces the list of commands available for the command line and the interactive shell.

3.3.1. Command Line Parameters

General syntax

‘> rce --[RCE argunents] -[RCP argunents] -[VM argunents]

Table 3.10. Command line argumentsfor RCE

Argument Type |Description

profile "<profile id or path>" RCE |Setsacustom profile folder to use. If only an id (any
valid directory name) is given, the profile directory
"<user home>/.rcefi d" isused. Alternatively, afull
filesystem path can be specified.

profile RCE |If the profile argument is specified without a profile

id or path, RCE launches the Profile Selection Ul,
which allows to select a profile folder for the startup as
described in Section 3.3.2, “Profile Selection Ul”.

batch "<command string>" RCE |Behaveslikethe "exec' command, but aso implies the
"--headless" option and always shuts down RCE &fter
execution.

headless RCE |Starts RCE in a headless modus without GUI. It will

remain in the OSGi console and waits for user input.

exec "<command string>" RCE |Executes one or more shell commands defined by
<command string>. For the list of available commands,
refer to the command shell documentation. This
argument is usually used together with --headless

to run RCE in batch mode. Multiple commands can

be chained within <command string> by separating
themwith " ; " (note the spaces); each command is
completed before the next is started.

You can usethe"st op" command at the end of the
command sequence to shut down RCE after the other
commands have been executed. However, any error
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Argument Type |Description

during execution of these commands will cancel the
sequence, and prevent the "st op" command from
being executed. To ensure shut down at the end of the
command sequence, use the - - bat ch option instead
of "- - exec".

Asanexample, rce --headl ess --exec

"wf run exanple.wf ; stop" will execute
the "example.wf" workflow in headless mode and
then shut down RCE. However, if the workflow
failsto start, RCE will keep running, asthe "st op"
command is never executed. To attempt execution
of the workflow file, but then always shut down
regardless of the outcome, user ce - - batch "wf
run exanpl e. wf" instead.

configure RCE |Startsthe RCE Configuration Ul (Section 2.2.3,
“Configuration UI”) which can be used to configure
SSH accounts with passphrases or to configure e-mail
support for the RCE instance.

data @noDefault RCP | Set the default workspace location to empty
consolel og RCP  |Logs everything for log files on the console as well.
console RCP Runs RCE with an additional OSGi console window,

which allows you to execute RCE shell commands.
See the Command Shell documentation for more
information.

Deprecated: console <port> RCP | Specify the port that will be used to listen for telnet
connections. (NOTE: this accessis insecure; configure
SSH access instead)

clean RCP  |Cleans before startup
vmargs VM Standard VM arguments
Dde.rcenvironment.rce. VM Sets the configuration directory

configuration.dir=
<insert-config-path>

Drce.network. VM Setsthe local node id, overriding any stored value.
overrideNodeld =<some-id> Thisis mostly used for automated testing.
Example:

"-Drce.network.overrideNodel d=
a96db8far62d59f 2d2782f 3e5e9662d4"

Dcommunication. VM Sets the block size to use when uploading datato a
uploadBlockSize= remote node. Thisis useful for very slow connections
<block sizein bytes> (less than about 10 kb/s) to avoid timeouts. The default

value is 262144 (256 kb).

Example:
"-Dcommunication.uploadBlockSize=131072" - sets
the upload block size to 128kb (half the normal size)

3.3.2. Profile Selection Ul

During startup of the instance, the Profile Selection Ul allows to select a profile folder which should
be used for the current run of RCE. Furthermore it allows to specify a default profile for future runs.
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You can access the Profile Selection Ul by executing RCE from the command line with the option
"rce--profile".

Figure 3.6. Profile Selection Ul

|2 Terminal =8 E=l <5

Profile Selection

Select Action
Select a profile and start RCE.

Zelect the default profile for future runs.
< Close >

If the first option "Select a profile and start RCE" is chosen, alist of available profiles is presented.
On selection of one of these profiles, RCE is started using this profile.

If the second option "Select the default profile for future runs' is chosen, alist of available profiles
is presented. On selection of one of these profiles, RCE will not be started using this profile, but
instead the selected profile will be marked as the default profile for future runs. This selection can
be temporarily overwritten again by using the '-profile "<profile id or path>"' option. The default
profile setting will be stored for the current user and the current installation location of RCE. Different
users on the same machine can therefore configure different default profiles. Furthermore, different
installations of RCE can have different default profiles configured.

Note

The Profile Selection Ul will only display profilesif they have been started once with RCE 7.0 or newer.

3.3.3. Command Shell

RCE providesan integrated shell (sometimesreferred to as* consol€e") for executing commands. It can
be accessed in three different ways:

» Start RCE with the "-console" command-line option, or add "-console" to the rce.ini file before
starting; this will open an OSGi console window. Due to the nature of an OSGi console, al
RCE commands must be prefixed with "rce". For example, type "rce help” to show the available
commands.

» Deprecated: Start RCE with the "-console <port>" command-line option; this will accept telnet
OSGi consol e sessions on that port. Aswith the"-console" option, RCE commands must be prefixed
with "rce" (for example, type "rce help").
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Note that this option is insecure, as there is no authentication nor encryption, so it should only be
used in fully trusted networks. Whenever possible, use the SSH console (see below) instead .

» Configure SSH access. To do so, refer to Section Configuration Parameters. After RCE has started,
you can access the shell on the configured port with a standard SSH client. On Windows systems,
the "putty” software works well asaclient.

Asthis option creates a pure RCE shell (as opposed to the OSGi consoles created above), you can
enter RCE commandswithout a prefix - for example, just type"help” tolist the avail able commands.
Note that to avoid confusion, adding a"'rce" prefix still works, but it is not necessary.

The following table lists some shell commands; more documentation coming soon.

Table 3.11. Shell Commands

Argument Description
help Lists all available commands.
auth Short form of "auth list".

auth create <group id> | Creates a new authorization group whith the given <group id> (an
identifier consisting of 2-32 |etters, numbers, underscores ("_") and/or
brackets).

auth delete <group id> | Deletes the local authorization group with the given <group id>.

auth export <group id>| Exports the group with the given group id as an <invitation string> that can
be imported by another node, allowing that other node to join this group.

auth import Imports a group from an <invitation string> that was previously exported

<invitation string> on another node.

auth list Lists the authorization groups that the local node belongs to.

cn Short form of "cn list".

cn add <target> Adds a new network connection. (Example: cn add activemg-

["<description>"] tep:reeserver.example.com:20001 "Our RCE Server")

cnlist Lists all network connections, including ids and connection states.

cn start <id> Starts/Connects a READY or DISCONNECTED connection (use "cn list"
to get theid).

cn stop <id> Stops/Disconnects an ESTABLISHED connection (use “cn list" to get the
id).

components Short form of "components list".

components list [-- Lists components published by reachable RCE nodes.

local] [--as-table]
The"--local" option only lists components provided by the local node.

The"--as-table" option formats the output as atable that is especially
suited for automated parsing.

components list-auth | Shows alist of all defined authorization settings. Note that these settings
are independent of whether a matching component exists, which means
that settings are kept when a component is removed and later added again.

components set-auth | Assigns alist of authorization groups to a component id. Note that
<component id> authorization settings always apply to all components with using thisid,
<groups> regardless of the component's version.

The <component id> needs to be defined as listed by the "components
list" command, e.g. "rce/Parametric Study"”, "common/MyIntegratedTool",
or "cpacs/MyCpacsTool". Thisid must be enclosed in double quotesif it

contains spaces.
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Argument

Description

The <groups> to assign need to be provided as comma-separated list of
user-defined authorization groups. This replaces any previously assigned
groups. Note that the specified groups must have been created or imported
beforehand; see the "auth create" and "auth import" commands for details.
Instead of alist of groups, the special value "public" can be used to grant
access to any user within the visible network, while "local" revokes any
previously granted access by remote users.

mail <recipient>
<subject> <body>

Sends an email to the specified recipient.

net

Short form of "net info".

net filter Shows the status of the IP whitelist filter.
net filter reload Reloads the | P whitélist configuration.
net info Lists all reachable RCE nodes.

ra-admin list-wfs

Liststheids of al published workflows.

ra-admin publish-wf
[-g <group name>]
[-K] [-t] [-p <JSON
placeholder file>]
<workflow file> <id>

Publishes aworkflow file for remote execution via"rarun-wf" using <id>.

-g name of the group in which the workflow will be shown in the Palette
on the client instance

-k (keep execution data): if set, the workflow execution data will not be
deleted after the workflow isrun

-t (temporary/transient): if set, the workflow is automatically unpublished
when the RCE instance is shut down

-p: adds a placeholder file for the given workflow; see the "wf run"
command's documentation for details. This operation verifies that the
workflow contains the required standard elements before publishing.

Note that a snapshot of the workflow file (and optionally, the given
placeholder file) is taken before publishing; subsequent changes of the
workflow file do NOT affect the published workflow.

ra-admin unpublish-wf
<id>

Unpublishes (removes) the workflow file with the given <id> from remote
execution.

restart Restarts RCE.

shutdown Shuts down the local RCE instance.
ssh Short form of "ssh list".

ssh add Adds a new ssh connection.
<displayName>

<host> <port>

<username>

<keyfilel ocation>

sshlist

Lists all ssh connections, including ids and connection states.

ssh start <id> Starts/connects the ssh connection with the given <id> (use" sshlist" to
get theid).

ssh stop <id> Stops/disconnects the ssh connection with the given <id> (use " ssh list" to
get the id).

stop Shuts down the local RCE instance (alias of "shutdown").

sysmon api Fetches system monitoring data from al reachable nodes in the network,

<operation> and printsit in aparser-friendly format.
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Argument Description
Available operations. avgcpu+ram <time span> <time limit> - fetches the
average CPU load over the given time span and the current free RAM.
Operation parameters: time span - the maximum time span (in seconds) to
aggregate load data over time limit - the maximum time (in milliseconds)
to wait for each node's load data response.

sysmon local/-| Prints system monitoring data for the local instance.

sysmon remote/-r

Fetches system monitoring data from al reachable nodes in the network,
and printsit in a human-readable format.

version Shows version information.
wf Short form of "wf list"
wf list Listsall current workflows, their states and execution ids.

wf cancel <workflow
execution id>

Cancels arunning or paused workflow.

wf delete <workflow
execution id>

Deletes afinished, cancelled or failed workflow from the data management
and disposesiit.

wf details <workflow
execution id>

Shows details about one workflow.

wf open <workflow

Opens aruntime viewer of aworkflow. Requires GUI. When using SSH,

execution id> this command is only available to users with the role devel oper.

wf pause <workflow |Pause arunning workflow.

execution id>

wf resume <workflow | Resume a paused workflow.

execution id>

wf run [--delete Executes the given workflow file and waits until it has completed.
<onfinished| Workflow file paths containing spaces must be enclosed in double quotes

awayslnever>] [--
compact-output] [-p
<placeholder value
file>] <workflow file>

...

The"--delete” option defines the deletion behavior after workflow
completion. Deleting aworkflow deletes al of itsfilesin the data
management and releases certain resources that may or may not be used
after it has finished, for example data to be visualized in component's
runtime views. The default of this setting is "onfinished": The workflow
isdeleted if it terminatesin state "Finished" (which means normal
completion without errors), otherwiseiit isleft unchanged for inspection.

The"--dispose" option defines the deletion behavior from the workflow
list. Disposing aworkflow does not delete its data from the data
management. The default of this setting is " onfinished".

The "--compact-output" option reduces this command's output as much as
possible, which isintended to simplify scripted calls of this command. The
first line printed will either be the workflow's assigned id if the start was
successful, or atext starting with " Er r or " if the workflow could not

be started. If (and only if) the start was successful, a second line will be
printed once the workflow has terminated. The pattern of this second line
is"<wor kfl ow i d>: <final state>".

The"-p" option can be used to define a placeholder value file (see below).

wf verify [--delete
<onfinished|always|
never>] [--pr

Runs several workflows and creates a summary of which ones failed and
succeeded.
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Argument Description

<paralel runs>] [-- The"--pr" option defines how often the workflow is started in parallel. The
sr <serial runs>] "--gr" options defines how often the workflow is started in serial. E.g. "--pr
[-p <placeholder 5 --sr 3" starts the workflow three times with five in paralld. If "*" is used

valuefile>] -- with the "--basedir" option or multiple workflow filenames are passed, "--

basedir <directory>  |pr" and "--sr" are applied for each of the workflows.

<workflow file>
[<workflow file> ..] |Forthe"--delete”, "dispose” and "-p" options refer to "wf run" above.

The "--basedir <directory>" parameter specifies the directory containing
the workflow files. File paths containing spaces must be enclosed in
double quotes (*...").

The second parameter defines the workflow's filenames. Using "*" as
workflow file runs all non-backup workflows in the basedir. Workflow file
paths containing spaces must be enclosed in double quotes ("...").

3.3.3.1. Configuration Placeholder Value Files

Someworkflow components use placehol dersfor configuration values. Thevaluesfor the placeholders
are defined at workflow start. When executing workflows from the command line (e.g. in headless or
batch mode), the placeholder's values must be defined in afile, which will be passed to the command
with the -p option. Placeholder value files have following format:

<conponent id>/<conponent version> : {
<configuration placeholder id>: <configuration val ue>
<conponent id>/<conponent version>/<conponent instance name> : {

<configuration placeholder id>: <configuration val ue>

}
}

Note

Every id and every value must be in enclosed in double quotes ("...").

Theconponent i distheid string of acomponent (e.g. de.rcenvironment.script), the conponent
ver si on isthe version of the component that is used in the workflow (e.g. 3.4).

There are two ways of defining values for configuration placeholders: per component type and
per component instance. When defined per component type, the id and version must be specified
(e.g. "dercenvironment.script/3.4"). When defined per component instance the component id,
component version, and the name of the component in the workflow must be specified (e.g.
"de.rcenvironment.script/3.4/MyScript"). In both cases, theconf i gur ati on pl acehol der id,
which is the name of the configuration placeholder, and the actual conf i gur ati on val ue must
be specified.

Component instance values override component type values.
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Note

It is possible to mix component type and component instance values.

Below isan example placeholder valuefile, which defines one placehol der value (component type) for
the script component, one placeholer value (component type) for the input provider component and a
placeholder value (component instance) for a specified input provider component of the workflow:

{

"“de.rcenvironment.script/3.4": {

"pyt honExecuti onPat h": "C:./Python/ python. exe"

b

"de.rcenvironnent.inputprovider/3.2": {
"inputFile": "C/input/globallnputFile.txt"

b

"de.rcenvironnent.inputprovider/3.2/Provider 1" : {

"inputFile": "C/input/Providerl. txt"

}
}

The following table lists components and their configuration placeholders.

Table 3.12. Components and their configuration placeholders

Component [Component id and version Configuration placeholders

Cluster de.rcenvironment.cluster/3.2 authuser - user name

authphrase - password (base64 encoded)

Input de.rcenvironment.inputprovider/3.2 | <output name> - value of output

Provider

Output de.rcenvironment.outputwriter/2.0 |targetRootFolder - path to target root folder

Writer

Script de.rcenvironment.script/3.4 pythonExecutionPath - path to the Python
executable (only required if Pythonis set as script
language)

3.4. Integration of External Tools

3.4.1. Basic Concepts

The Tool Integration concept of RCE is used to integrate external tools for calculations, simulations
and so on into RCE and use them in a workflow as a component. The tools must fulfill these
requirements:
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» Theexternal tool must be callable via command line

* It must have a non-interactive mode which is called viacommand line

* Input for the tool must be provided through command line arguments or files

If these requirements are fulfilled, a configuration file can be created that is used for the integration.
If you use RCE with a graphical user interface this can be done with the help of an wizard which
guides you through the settings. This wizard can be found in the menu Tool Integration -> Integrate

Tool.... Required fields are marked with an asterisk (*). When the wizard is finished and everything
is correct, the integrated tool will automatically show up in the Workflow Editor palette.

Note

Thewizard has adynamic help, which is shown by clicking on the question mark on the bottom left or by pressing
F1. It will guide you through every page of the wizard.

3.4.2. Directory Structure for Integrated Tools

When executing an integrated tool, a certain directory structure is created in the chosen working
directory. This structure depends on the options you have chosen in the integration wizard. The two
options that matter are "Use a new working directory each run" and "Tool copying behavior".

,Use a new working directory on each run” not selected
,,Do not copy tool” selected

,Use a new working directory on each run“ not selected
,,Copy tool to working directory once” selected

Root Working Directory Root Working Directory

Working Directory Working Directory

Config Directory Config Directory

!
!

Input Directory Input Directory

Output
Directory

Output
Directory

Tool Directory

|

Some File System Path

Tool Directory

,Use a new working directory on each run“ selected
,,Copy tool to working directory once” selected

Root Working Directory

-

Tool Directory

Working Directory
1,2,..)

Config Directory

Input Directory

Output
Directory

,Use a new working directory on each run“ selected
,,Copy tool to working directory on each run” selected

Root Working Directory

Working Directory
(1,2,..)

Config Directory

Input Directory

Output
Directory

Tool Directory
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Root Working Directory: This is the directory you choose in the "Tool Integration Wizard" as
"Working Directory" on the "Launch Settings" page.

Config Directory: In this directory, the configuration file that may be created by the tool integration
will be created by default. The configuration files can be created from the properties that are defined
for the tool on the "Tool Properties’ page.

Input Directory: All inputs of type "File" and "Directory" will be copied here. They will have a
subdirectory that is named exactly as the input's name (e.g. the input "x" of type "File" will be put
into "Input Directory/x/filename").

Output Directory: All outputs of type"File" and "Directory" can be written into this directory. After
that, you can use the placeholder for this directory to assign these outputs to RCE outputs in the post
execution script. To write the output directory into an output "x" of type "Directory” the following
linein the post execution script would be required: ${ out:x} ="${ dir:output}"

Tool Directory: Thisisthedirectory, where the actual tool islocated. If thetool should not be copied,
it will be exactly the same directory that you choose, otherwise it will be the same as the chosen
directory but copied to the working directory.

Working Directory: A working directory is always the location, where all the other directories will
be created. If the option "Use a new working directory on each run" is disabled, this will always be

the same as the "Root Working Directory”. Otherwise, a new directory is created each run (the name
will be the run number) and is the working directory for the run.

3.4.3. Copying of Integrated Tools

When a component is created in the integration wizard, a configuration file is created.
All configuration files from the tool integration are stored in the directory
<profile folder>/integration/tools/

In this directory, there is a separation between different kinds of integration realized through one
subdirectory for each. The cormon folder is always existent.

In these subdirectory, the integrated tools are stored, again separated through a subdirectory for each.
The name of the directory equals the name of integration of the tool.

If an integrated tool should be copied to another RCE instance or another machine, the directory of the
tool must be copied, containing aconf i gur ati on. j son and some optional files. It must be put
in the equivalent integration type directory of the target RCE instance. After that, RCE automatically
reads the new folder and if everything isvalid, the tool will be integrated right away.

Note

If you want to delete a tool folder that contains some documentation, this can cause an error. If you have this
problem, delete the documentation folder at first (it must be empty), afterwards you can delete the tool folder.

3.4.3.1. Tool Execution Return Codes

The tools are executed by using a command line call on the operating system via the "Execution
Script". When the tool finished executing (with or without error), its exit code is handed back to the
execution script and can be analyzed in this script. If in the script nothing elseis done, the exit codeis
handed back to RCE. When thereisan exit codethat isnot 0", RCE assumes that the tool crashed and
thus lets the component crash without executing the "Post Script”. Using the option "EXit codes other
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than 0 isnot an error" can prevent the component to crash immediately. With this option enabled, the
post script wil be executed in any way and the exit code from the tool execution can be read by using
the placeholder from "Additional Properties'. In this case, the post script can run any post processing
and either not fail the component, so the workflow runs as normal, or let the compoennt crash after
some debugging information was written using the Script APl "RCE.fail("reason")".

3.4.4. Integration of CPACS Tools

3.4.4.1. Additional concepts of CPACS Tool Integration

Extending the common Tool Integration concept, the CPACS Tool Integration has some additional
features.

e Parameter Input Mapping (optional): Substitutes single values in the incoming CPACS content,
based on an X Path configured at workflow design time as a dynamic input of the component

* Input Mapping: Generates the tool input XML file as a subset of the incoming CPACS file XML
structure, specified by a mapping file

e Tool Specific Input Mapping (optional): Adds tool specific data to the tool input file, based on a
mapping file and adata XML file

» Output Mapping: Merges the content of the tool output XML file into the origin incoming CPACS
file, based on a mapping file

» Parameter Output Mapping (optional): Generates output val ues as single values of the CPACSresult
file, based on an XPath configured at workflow design time as a dynamic output of the component

» Execution option to only run on changed input: If enabled, the integrated tool will only run on
changed input. Therefore the content of the generated tool input file is compared to the last runs
content. Additionally the data of the static input channels are compared to the previous ones.

All the features listed above can be configured in the tool integration wizard on the dedicated CPACS
Tool Properties page.

The mappings can be specified by XML or XSLT as shown in the following examples. RCE
differentiates between these methods in accordance to the corresponding file extension (.xml or .xgl).

Example for an input or tool specific XML mapping :

<?xm version="1.0" encodi ng="UTF- 8" ?>
<map: mappi ngs xm ns: map="http://wwmv. r cenvi ronnent . de/ 2015/ mappi ng" xni ns: xsl ="http://ww. w3. or g/ 1999/
XSL/ Tr ansf or ni' >

<map: mappi ng>
<map: sour ce>/ cpacs/ vehi cl es/ ai rcraft/ nodel / r ef er ence/ ar ea</ map: sour ce>
<map: target >/tool | nput/data/var 1</ map: t ar get >

</ map: mappi ng>

</ map: mappi ngs>

And input or tool specific XSLT mapping:

<?xm version="1.0" encodi ng="utf-8"?>
<xsl : styl esheet version="1.0" xnlns:xsl="http://ww.w3. org/ 1999/ XSL/ Transfornt* xnl ns: xsi ="http://
www. W3. or g/ 2001/ XM_.Schena- i nst ance" xsi : noNanespaceSchenalLocat i on="cpacs_schena. xsd" >

<xsl :output nethod="xm" nedia-type="text/xm" />

<xsl:tenplate match="/">

<t ool | nput >
<dat a>
<var 1>
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<xsl :val ue- of sel ect="/cpacs/vehicles/aircraft/nodel/reference/area" />
</var 1>
</ dat a>
</tool | nput >
</ xsl :tenpl at e>
</ xsl : styl esheet >

Example of an output XML mapping:

<?xm version="1.0" encodi ng="UTF- 8" ?>
<map: mappi ngs xm ns: map="http://ww. r cenvi r onment . de/ 2015/ mappi ng" xm ns: xsl ="htt p: // www. w3. or g/ 1999/
XSL/ Tr ansf or ni' >

<map: mappi ng node="del et e" >

<map: sour ce>/ t ool Qut put / dat a/ r esul t 1</ map: sour ce>

<map: t ar get >/ cpacs/ vehi cl es/ ai rcraft/ nmodel / ref erence/ ar ea</ map: t ar get >
</ map: mappi ng>

</ map: nappi ngs>

And output XSLT mapping:

<?xm version="1.0" encodi ng="UTF-8"?>
<xsl:styl esheet version="1.0" xm ns:xsl="http://ww.w3. org/ 1999/ XSL/ Transfornt xm ns: xsi="http://
www. W3. or g/ 2001/ XM_Schena- i nst ance" excl ude-resul t-prefixes="xsi">
<xsl:out put method="xm " version="1.0" encodi ng="UTF-8" indent="yes"/>
<!--Define Variable for tool Qutput.xm-->
<xsl:variabl e nane="t ool Qutput Fi | e" sel ect=""./Tool Qut put/tool Qutput.xm"'"/>
<!--Copy conplete Source (e.g. CPACSInitial.xm) to Result (e.g. CPACSResult.xm)-->
<xsl:tenplate match="@ | node()">
<xsl : copy>
<xsl:apply-tenpl ates select="@ | node()"/>
</ xsl : copy>
</ xsl : tenpl at e>
<!--Mdify a value of an existing node-->
<xsl:tenpl ate mat ch="/cpacs/ vehicl es/ ai rcraft/nodel /reference/ area">
<ar ea>
<xsl : val ue- of sel ect="docunent ($t ool QutputFile)/tool Cutput/data/resultl"/>
</ area>
</ xsl : tenpl at e>
</ xsl : styl esheet >

Please ensure to use the proper namespace for map (xmlns:map="http://www.rcenvironment.de/2015/
mapping") in XML mapping files.

Thefigurebelow illustrates how the additional featuresare used in the run process of an user-integrated
CPACS tool.
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Figure 3.7. Run process of an user-integrated CPACS Tool
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3.4.4.2. Integrate a CPACS Tool into a Client Instance

1. Start RCE as Client

2. Open the Tooal Integration Wizard by clicking the Integrate Tool... in the File menu.
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4

»

~

Note

You will always find further help by clicking the ? on the bottom left corner on each page of the wizard or
by pressing F1.

. Choose the option Create a new tool configuration from a template.

Note

The CPACS templates delivered with RCE are designed to match the conventions of the old CPACS tool
wrapper (respectively Model Center tool wrapper). Most of the properties are preconfigured and do not need
to be changed.

. Select one of the CPACStemplates.
Click Next.

. Fill in the Tool Description page.
Click Next.

. On the Inputs and Outputs page you will find preconfigured static in- and outputs, that will match
the old tool wrapper conventions. If your tool needs additional in- or outputs, feel freeto configure.
Click Next.

. Skip the page Tool Properties by clicking Next since it is not relevant for tools that match the
conventions of the old CPACS tool wrapper.

. Add alaunch setting for the tool by clicking the Add button on the Launch Settings page. Configure
the path of the CPACS tool and fill in a version, click OK. If you would like to allow users of
your tool to choose that the temp directory won’t be deleted at all after workflow execution, check
the property Never delete working directory(ies). Not to delete the working directory can be very
useful for users for debugging purposes, at least if they have access to the server’s file system.
But this option can result in disc space issues as the amount required grows continuously with
each workflow execution. It is recommended to check that option during integrating the tool and
uncheck it before publishing the tool.

Click Next.

. The CPACS Tool Properties are preconfigured to match the folder structure defined for the old
CPACS tool wrapper. In most cases you do not have to change this configuration. If you are using
XSLT mapping, please select the corresponding mapping files. If your tool does not work with
static tool specific input, please deselect this property.

Click Next.

10.In the Execution command(s) tab on the Execution page, you need to define your execution

1

command itself as well as optiona pre and post commands. Commands will be processed
sequentially line by line. An example for a typical Windows command including pre and post
commands will ook like the following:

rem pre- command
pre. bat

rem tool - execution
Your Tool . exe Tool | nput/tool | nput.xm Tool Qut put/t ool Qut put . xm

rem post - conmand
post . bat

1.Click Save and activate and your tool will appear immediately in the palette and is be ready to use.

12.If not already done, do not forget to publish your tool (cf. SectionSection 3.5, “Tool publishing

and authorization” ) after testing it locally. To check if your tool is successfully published to the
RCE network open the tab Network View at the bottom and checkout Published Components after
expanding the entry of your RCE instance.
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3.4.4.3. Integrate a CPACS Tool into a Server Instance in
Headless Mode

Theway to integrate a CPACStool on aserver running RCE in headless mode is as follows. Perform
the stepsto integrate a CPACS tool on aclient instance and make sure that the path of the CPACStool
configured on the Launch Settings page (step 8) matches the absol ute tool path on your server system.
Afterwards, youwill find the configuration filesinside your rce profilefolder at thefollowing location:

/integration/tool s/cpacs/[ Your Tool Nane]

Copy thefolder [ Your Tool Nane] to the same location inside the profile folder running with your
headless server instance. Use the "auth" commands (cf. SectionSection 3.5, “Tool publishing and
authorization” ) to publish your tool. If the server instance is already running, your tool will be
available immediately after publishing.

3.5. Tool publishing and authorization

3.5.1.

RCE components and integrated tools can be published to make them usable by other connected
("remote") RCE instances. The publishing options for each component/tool can be defined in the
"Component Publishing" view. In this view, each component can be assigned to one of three basic
publication levels:

* Loca (the default option): Components with the "local" setting can only be used on the local
instance; they are not visible to other instances.

» Custom: This setting allows to make the component/tool available only to specific groups of users.
To use this setting, one or more authorization groups have to be created first, which is explained
in the next section. Each component/tool can then be assigned to one or multiple groups. Users on
remote instances can see and use components if they are members of at least one of these groups.

 Public: Components with the "public" setting can be used by all connected RCE instances. Thisis
equivalent to the tool and component publishing in earlier versions of RCE. Tools in the "public"
group are also available over SSH connections.

Note

If the "Component Publishing” view is not visible, you can open it from the "Window > Show View" menu. If it
isnot listed there, choose "Other" and select them from the "RCE" category.

Managing authorization groups

Authorization groups can be created and managed in the "Authorization Groups' dialog, which can
be opened from the "Component Publishing" view. To create a new group, click the "Create Group"-
button and enter a name for the group. To provide access to this group to other users, select the group
in the list and click "Export Group Key". Copy the provided key from the dialog that appears, and
pass it on to the users that you would like to invite to this group.

Note

IMPORTANT: This exported group key is similar to a password. When passing it to other users, make sure to
use acommunication medium that unauthorized users cannot easily intercept. For example, passing the key viaan
encrypted chat system provided by your employer, or a Team Site that is only accessible to project members, is
usually secure enough. On the other hand, sharing it by email outside of your organization is usualy unsafe, and
we recommend using more secure alternatives.

When the other user receivesthiskey, they can import it into their RCE instance by using the "Import
Group Key" buttonin their "Authorization Groups' dialog. After importing akey on an RCE instance,
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all toolspublished for that group on connected RCE instancesare visible and can be used likea" public"
component.

3.5.2. Publishing tools on the command console

Creating custom tool groups and publishing tools is also possible using the "auth" commands on the
command line. A short reference:

e auth create <nane> - creates an authorization group
e« auth |ist -listsavailable access groups

« auth del ete <nane/i d> - deetes an authorization group; if the name is ambiguous (e.g.
there are two groups named "groupName"), you need to add the randomly generated id behind it,
separated with acolon (e.g. gr oupNane: 2716ab2d25)

e« auth export <name/i d> - exportsagroup key in aform that can be imported by another
instance via GUI or command line

« auth inmport <exported key>-importsagroup key exported viaGUI (as described above)
or viatheaut h export command. The group name is embedded in the exported key, and is
set automatically.

e conmponents set-auth <conponent id> <perm ssions> - sets the permissions

for a component. Possible values for "permissions’ are either "l ocal *, "publ i c¢", or acomma
separated list of authorization groups/ids.

e components |i st-auth -showsalist of al defined authorization settings. These settings are
independent of whether a matching component exists, which means that settings are kept when a
component is removed and later added again.

The component ids used in this commands can be derived as follows:
» rce/ <conponent nane> for standard RCE components, e.g. "r ce/ Paranet ri ¢ St udy”
« comon/ <t ool nane> for integrated tools of type"common” e.g. "conmron/ Exanpl eTool "

» cpacs/ <t ool nanme> for integrated tools of type "CPACS' eg. "cpacs/
CPACSExanpl eTool "

3.6. Remote Tool and Workflow Access

RCE provides an interface that allows external applications to access and run single tools or complete
workflows within RCE instances. This allows existing applications to make use of RCE's features
(like network distribution, data management, logging, ...) when integrating the application itself is not
possible or desirable. For example, applications that are based on frequent user interaction are not a
good fit for being run as part of an automated workflow, but may still want to use some of RCE's
features.

This section describes how to publish tools or workflows such that they can be used via Remote
Access. It will guide you through the creation of a simple example, which you can expand to build
your own solutions.
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3.6.1.

3.6.2.

3.6.3.

Basic Concepts

The basic ideaof the Remote Accessinterfaceisthat the external application opensan SSH connection
to RCE, and initiates the tool or workflow execution via text commands. Input and output data, as
well aslog files, are transfered using SCP. For using the integrated tools and workflows remotely, a
standal oneremote accesstool iscurrently under devel opment and will bereleased soon. Theintegrated
tools can also be used in aremote RCE instance via SSH connections.

Tool vs. Workflow Execution

In RCE 5.0.0, the "remote access' feature was able to invoke a single integrated tool. Starting with
RCE 5.1.0, arbitrary user-defined workflows can be executed. The following sections describe each
approach separately.

Setting up the Single Tool Execution Example

These steps will guide you through the configuration of an integrated tool. Using this example, you
will be ableto easily integrate your own text-based toolsinto RCE and invoke them using the Remote
Accessinterface.

 Setting RCE up as a"Remote Access Server".
« Download and unpack/install an RCE distribution.
e Start RCE and select the "Help > Configuration Information" menu option. From the list of
configuration examples, double-click "Remote Access Server" to open it. Mark all text (Ctrl-A)

and copy it to the clipboard (Ctrl-C).

¢ Select the "Help > Open Configuration File" menu option, select all text (Ctrl-A) and paste the
copied text from the example configuration.

« Savethefile, and select "File> Restart" to apply the new configuration. The Remote Access SSH
interfaceisnow running, with apre-configured SSH account of "ra_demo", password "ra_demo".

Note

IMPORTANT: "ra_demo" is just an example account for testing within a secure network. Create a new
account with a better password (for example using the configuration Ul described in the "Configuration"
section) before using the Remote Access interface in production. Publishing tools using this default account
isapotential security risk.

 Define an example tool using the following steps.
» Select the "File > Integrate Tool" menu option.

 Follow the tool integration wizard to integrate your tool (more information can be found using
the help function in RCE and in the chapter "Integration of External Tools" of this user guide.

 Publish your tool in the "public" group (cf. Section 3.5, “Tool publishing and authorization” ) to
make the tool available via Remote Access.

* You now have an example tool that can be accessed with the "Remote Access' feature. How to
setup aclient to access thistool see the "Configuring an RCE instance as an SSH client” section

e To get an impression of how this feature interacts with existing RCE features, you can examine
several areas within the RCE instance.
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« Open the "Workflow List" view in RCE and watch it while the "run-tool" script is executing.
After a short preparation time where the input data is uploaded, you will see the automatically
generated workflow containing the tool being executed. It will disappear automatically if it
finishes successfully; if it fails, it will remaininthelist for review.

» Open the "Workflow Console" view; if the tool produced any output, it should be visible there.

» Openthe "Workflow Data Browser" and refresh it; there should be a"Remote Tool Access-..."
workflowe entry matching the remote tool run. When you expand this entry, you should see the
uploaded content of the input folder, the generated output folder, any generated text output (in
the "Execution Log" folder), and the exit code of the tool process (also in the "Execution Log"
folder). It will disappear automatically if the tool finishes successfully

3.6.4. Setting up the Workflow Execution Example/
Template

These steps will guide you through the creation of a remote-executable workflow, and will show you
how to invoke it using the provided example scripts.

Download and unpack/install an RCE distribution.

Run RCE and select the "Help > Open Configuration Information” menu option. From the list of
configuration examples, double-click "Remote Access Server" to openit. Mark al text (Ctrl-A) and
copy it to the clipboard (Ctrl-C).

Select the "Help > Open Configuration File" menu option, select al text (Ctrl-A) and paste the
copied text from the example configuration.

Save thefile, and select "File > Restart" to apply the new configuration. The Remote Access SSH
interface is now running, with a pre-configured SSH account of "ra_demo", password "ra_demo".

Note

IMPORTANT: "ra_demo" isjust an example account for testing within a secure network. Create a new account
with a better password (for example using the configuration Ul described in the " Configuration” section) before
using the Remote Access interface in production. Publishing tools using this default account is a potential
security risk.

As afirst example we are going to execute the umodified "Remote Workflow_Access Template"
workflow file in the Workflow Examples Project. If you haven't created this project aready, right-
click in the Project Explorer on the left side, and choose "New > Workflow Examples Project”, and
choose aname for it. The template file is contained within the project folder. To get an impression
of the basic setup, open the template workflow file. Y ou will see an SCP Input Loader on the left
side with two outputs. On theright side, there is an SCP Output Collector with one input (these two
are helper componentsthat are only used for remote access workflows). These are the points where
the Remote Workflow Access feature sends the provided inputs into your workflow, and collects
the final outputs.

As a security measure, you need to explicitly publish your workflow to alow remote access to it.
Thisis done viaa console command at this time; future RCE versionswill most likely add a option
to do this from the GUI. To issue this command, open the "Command Console" view (if it is not
aready visible) by selecting "Windows > Show View > Other" from the menu, and then double-
clicking "Command Consol€e" in the "RCE" section.

Right-click your workflow filein the "Project Explorer" and select the " Copy full path" entry inthe
popup menu to copy the full path to the workflow file to the clipboard.
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Note

This step demonstrates how the get the path of a workflow file in the current workspace, but you can use
workflow files that are located anywhere on your system.

» Tomaketheworkflow availablefor remote execution, enter thecommandr a- adm n publ i sh-
wf "<workflowfile>" <i d>inthecommandwindow. PressCtrl-V inplaceof <wor kf | ow
file> to insert the path to your workflow file there. For <i d>, choose a string (without
whitespace) that callers can use to execute the workflow. Press "enter" to execute the command.
The workflow file will be inspected, and you will either see a message describing what is missing,
or a message that the workflow was successfully published. Fix any errors until the workflow is
published.

Note

Starting with RCE 6.2.0, published workflows are persistent by default, so they will still be available after the
local RCE instanceisrestarted. Usether a- admi n unpubl i sh-wf <i d>command to remove apublished
workflow from remote access.

To publishaworkflow for the current RCE instance'slife-timeonly, usethe- t option: r a- admi n publ i sh-
w -t "<workflow file>" <id>.

* If some of the workflow's components use placeholders for configuration values, you can use the
- p option to specify aplaceholder valuesfile. The structure of placeholder valuefilesis explained
in Section 3.3.3.1, “Configuration Placeholder Value Files’. Placeholder files can used with both
persistent and non-persistent workflows (see above).

Example. ra-admin publ i sh-wf -p myPl acehol der Val ues. j son
myWor kf | owFi | e. wf nmyPubl i shld

» You now have aworkflow file that can be executed using the "Remote Access' feature.

» To get an impression of how this feature interacts with existing RCE features, you can examine
several areas within the RCE instance.

* Open the "Workflow List" view in RCE and watch it while the "run-wf" script is executing.
After ashort preparation time where the input datais uploaded, you will see the workflow being
executed. It will disappear automatically if it finishes successfully; if it fails, it will remain in the
list for review. Y ou can aso double-click on arunning or workflow to monitor its execution.

* Open the "Workflow Console" view; if the tool produced any output, it should be visible there.

* Openthe"Workflow DataBrowser" and refresh it; there should be an entry for the Remote Access
workflow. When you expand this entry, you should see the uploaded content of the input folder,
the generated output folder, any generated text output (in the "Execution Log" folder), and the
exit code of the tool process (also in the "Execution Log" folder).

3.6.5. Building Your Own Remote Access Workflow

After running the exampl e/template workflow as described in the previous section, you can proceed
to building your own actual workflow.

As described above, open the "Remote Workflow_Access Template" workflow file. You will seean
SCP Input L oader on the left side with two outputs. On theright side, thereisan SCP Output Collector
with one input (these two are helper components that are only used for remote access workflows).
These are the points where the Remote Workflow Access feature sends the provided inputs into your
workflow, and collects the final outputs. Y ou can change the data types or add/del ete inputs/outputs
in the properties view of the input loader/output collector. The Script component in the middleisjust
aplaceholder - unless you need a Script component anyway, you can just delete it.
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There are two basic approaches to building your workflow:

« Either you start with the template, and build your workflow between the two standard components.
This is straight-forward, but means that you cannot test run the workflow from the RCE GUI (as
the Input Loader will fail), but have to use the Remote Access feature to test it.

e The other approach is to build your workflow normally, where you add an SCP Input Loader and
SCP Output Collector with the outputs and inputs you need. You can then test (and if needed,
modify) your workflow from the GUI until it behaves as it should. Then, mark al components
except the Input Provider and Output writer in your workflow, and select "Copy" from the right-
click menu. Switch to the template file, click an empty area, and select "Paste” from the right-click
menu. Then, connect the two template components (Input Provider and Output Writer) as in your
origina workflow.

Note

(Advanced Usage) You can also build your workflow in the template file, add your own Input Provider and
Output Writer, and use the new "Enable/Disable Component" feature to toggle between them for testing and
Remote Access usage. As this reguires some helper components to work, thisis not recommended for your first
example, but may be a useful trick to keep in mind.

After you have finished building your workflow, the process of publishing and executing it is the
same as described above for the unmodified template file. Please note that publishing your workflow
for remote execution automatically creates an (invisible) copy of it. Modifications you make to your
workflow file are not published right away. Once you have made the changes you want to publish, run
the same "ra-admin publish-wf" command again to update the published version.

Note

Tip: To repeat a previous command, presse the "up arrow" key in the Command Console window.

3.7. Connecting RCE instances via the RCE
network or via SSH connections

RCE provides two possibilities to connect your RCE instance to other RCE instances and to use the
user-integrated tools and components published on those instances: The RCE network connections
and SSH connections. RCE connections are meant to be used only in a trusted network (e.g. your
institution'sinternal network). The RCE network traffic is currently not encrypted. This meansthat it
isnot secureto expose RCE server portsto untrusted networkslike theinternet. In the casethat it isnot
possible or not secure to use RCE connections, SSH connections provide a more secure aternative.
The following table compares the two connection types:

Table 3.13. Connection types

Connection type | Access to|Supporting all RCE|Encrypted |Using login Symmeﬂrical
all published|network  functions|traffic name and
tools (eo. remote passwor d or
monitoring) RSA key
RCE connections |yes yes no no yes
SSH connections |yes no yes yes no
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3.7.1.

3.7.2.

RCE Network Connections

RCE connections are meant to be used only in a trusted network (e.g. your institution's internal
network). To build up anetwork of RCE instances, at |east one of the instances has to be configured as
aserver (see the "Configuration" section or the sample configuration file "Relay server” for details).

On the client side, RCE network connections can be added in the "network" view by clicking "Add
network connection" and entering the hostname and port of an RCE server instance. The connections
are shown in the "RCE Network"->"Connections" subtree. They can also be edited, connected and
disconnected in the network view. However, the changes made here are not saved in the configuration
yet, i.e. they will be lost when RCE is closed or restarted. To permanently add connections, you can
edit the configuration file (see the "Configuration" section for details).

In the "RCE Network" -> "Instances' subtree all RCE instances in the network are listed. When
expanding the entry for an instance, you can see monitoring data like CPU or RAM usage for this
instance, and the published components and tools of thisinstance (if it has any).

The published components and tools of the other instances in your network are also shown in the
palette of the Workflow Editor. From there, you can use them in your workflows just like your local
components and tools. When you start a workflow, in the "Execute Workflow" wizard there is an
overview which component will be run on which RCE instance. If acomponent is available on several
instances, you can choose here on which instance it should be run. In the same wizard, you can also
choose another instance asthe " Controller Target Instance”, which meansthat the workflow execution
will be controlled by thisinstance (see the section " Configuration Parameters’ for more information).
This can be useful when you start along-running workflow where all components are run on remote
instances and you do not want to keep your local computer connected all the time.

SSH Remote Access Connections

SSH connections provide a more secure aternative to the standard RCE connections and can be used
to access tools remotely. The published tools are shown in the palette of the client's Workflow Editor
(this may take a few seconds after connecting, as the tool list is fetched from the remote hosts every
few seconds). From there, you can use them in your workflows just like your local components and
tools. Differently from tools accessed by RCE network connections, in this case the component is
shown to be executed on your local instance in the Workflow Execution wizard.

Also workflows that were published on the remote instance (for information about the publishing see
section "Remote Tool and Workflow Access') are shown as components in the pal ette of the client's
Workflow Editor in the group " SSH Remote Access Workflows' (if the client runsRCE 7.1 or newe).
These remote workflows can be added to workflows and executed like local components/tools.

3.7.2.1. Configuring an RCE instance as an SSH server

The RCE instance that publishes the tool, or another instance connected to it by RCE network
connections, hasto be configured as an RCE remote access server (see the "Configuration™ section or
the sample configuration file "Remote access server” for details).

Note

When configuring an SSH account using a key file, note that for using key files, both server and client have to run
RCE 7.1 or newer and that only RSA-Keysin the OpenSSH format are supported by RCE. Y ou can generate such
keys on Linux e.g. using the "ssh-keygen" tool (which creates the correct format by default). On Windows, you
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can use the software "puttygen” to generate a key (choose the type "SSH-2 RSA™) and convert it to the OpenSSH
format ("Conversions'->"Export OpenSSH key" in puttygen).

3.7.2.2. Configuring an RCE instance as an SSH client

On the client side, SSH connections can be added in the "network" view by clicking "Add SSH
Remote Access Connection”. In the following dialog, enter the hosthame and port of an RCE
instance that provides an SSH server as well as the user name and the authentication data of an SSH
account configured on this instance. Depending on the SSH account, you have to authenticate using
a passphrase or by an RSA private key file. If your private key is protected by a passphrase, select
the authentication type "Keyfile with passphrase protection”, else select "Keyfile without passphrase
protection”.

The connections are shown in the "SSH Remote Access'->"SSH Remote Access Connections'
subtree. They can aso be edited, connected and disconnected in the "network" view. It is possible to
store passphrases using the Eclipse Secure Storage Mechanism (this is only available on Windows).
However, the changes made here are not saved in the configuration yet, i.e. they will be lost when
RCE is closed or restarted. To permanently add SSH connections, you can edit the configuration file
(see the "Configuration" section for details). However, it is not possible yet to store the passphrases
for such connections permanently.

3.7.3. Example Structure of an RCE network with
several project partners

This section describes how an RCE network with several project partners could be structured. RCE
provides two different types of connections between RCE instances which can both be used to access
published tools:

Standard RCE connections are meant to be used in atrusted (internal) network, as the data exchanged
via those connections is not encrypted. These connections are bidirectional and allow to share more
datathan just theinformation about published tools (e.g. they can be used to access data about executed
workflows on another instance).

RCE SSH connections use the SSH protocol to provide an encrypted connection. They are meant to
securely connect RCE instances from different institutions over the internet. These connections are
one-directional and alow the client to run published tools and workflows on the server (of course,
both instances can be configured as client AND server at the same time if necessary so they can use
each other’ stools).

In practice, most partners will probably use both types of connections: RCE connections to connect
different RCE instances within their institution and SSH connections to connect to the other partners.
The following figure gives an example of how such a project network could be structured:
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Figure 3.8. Example RCE network
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The four project partners in the example all have an internal network of RCE instances which are
connected by standard RCE connections. SSH connections are used to connect between the different
partners. Therefore, each partner who wants to publish tools to other partners has one RCE instance
which is configured as an SSH server. Only this one instance per institution has to be reachable via
SSH over the internet, all other instances in the institution’s internal network can be connected to it
by standard RCE connections and still publish tools to the other partners/access tools published by
other partners.

In the example, the RCE instances in Partner A’s network can access the tools published in Partner
C’snetwork and vice versa. One of the instances from Partner D can access Partner C'stools; and all
the partners can access the tools in Partner B’ s network.

Each institution in the example has a different internal setup, al of which are possible:

Partner A has a dedicated RCE server where the published tools are located, which is connected to
the SSH server by an RCE connection. All other RCE users in the internal network are connected to
this server.

Partner B has put all the tools directly on the SSH server.

In Partner C's network, some tools are located on the SSH server, but some tools are also published
by users directly on their own machines. Aslong as they are connected to the SSH server, also those
tools can be used by the other partners.

Partner D has not published any tools and has no SSH server, instead the users' computers connect
directly to the other partner’s SSH servers.
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Appendix A. Script APl Reference

This section contains a reference for the API that is accessible viathe script component.

M ethod Description

def RCE.close_all _outputs () Closes all outputs that are known in RCE.

def RCE. cl ose_output ( nane ) Closes the RCE output with the given name

def RCE.fail ( reason ) Fails the RCE component with the given reason

def RCE. get _execution_count ( ) Returns the current execution count of the RCE
component

def Returns al input names that have got a data value

RCE. get _i nput _nanes_wi th_datum

()

from RCE.

def RCE. get_output _nanes ( ) Returns the read names of all outputs from RCE

def RCE.get_state_ dict () Returns the current state dictionary

def RCE.getallinputs () Gets adictionary with all inputs from RCE

def RCE.read _input ( nane ) Getsthevaluefor thegiveninput nameor an error,
if theinput is not there (e.g. not required and it got
no value)

def RCE.read_input ( nane , |Getsthevauefor thegiveninput name or returns

defaul tval ue )

the default valueif thereisno input connected and
the input not required

def RCE. read_st at e_vari abl e |Reads the given state variables value, if it exists,
( nane ) else None isreturned
def RCE. r ead_st at e_vari abl e|Reads the given state variables value, if it exists,

( name, defaul tval ue )

else a the default value is returned and stored in
the dictionary

def RCE.wite _not_a val ue_out put
( nane )

Sets the given output to "not avalue' data type

def RCE. wri t e_out put ( nane, |Sets the given value to the output "name" which
val ue ) will be read from RCE

def RCE. wite_state_vari abl e|Writes a variable name in the dictionary for the
( nane, value ) components state
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